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Visual Basic 是目前國內使用者最多的程式語言之一，對於熟悉 Visual 

Basic 的使用者來說，行動 App 開發雖然是當紅的軟體開發領域，但是，苦於

不熟悉 Java/Objective-C 語法和物件導向程式設計，根本無法入門，現在，你

不用學習 Java/Objective-C 語言的完全不同語法，可以直接使用現有 Visual 

Basic 程式設計經驗，一樣可以輕鬆跨平台開發 Android 和 iOS App。 

Android 是 Google 公司開發；iOS 是 Apple 公司開發的行動作業系統，也

是目前巿佔率最高的前兩大行動作業系統平台。 

Basic4android（B4A）是一套整合開發環境 IDE，可以讓 Visual Basic 語

言的開發者直接使用 BASIC 語言開發 Android App，B4A 能夠將開發者撰寫

的 BASIC 程式碼編譯轉換成 Java 程式碼來建立原生 Android App。換句話說，

B4A 專案最後仍然會編譯成原生 Java 程式檔案和類似 Eclipse IDE 的 Android

專案資料夾結構，我們不只可以使用 B4A 開發 Android App，更可以將它作

為一個橋樑來進入進階 Java 語言的 Android 程式開發。 

Basic4iOS（B4i）是 B4A 的兄弟產品，可以讓我們使用相同觀念和語法

來開發 iOS App，輕鬆使用 Visual Basic語言在 Windows作業系統進行 iOS App

開發，只需一台 iPhone 手機+iOS 開發者帳號，你連 Mac 電腦都不用購買（使

用 B4i 雲端建構服務），就可以開發和測試執行 iOS App。 

事實上，B4A 和 B4i 使用的 BASIC 語言非常類似微軟.NET 的 Visual Basic

和 VB 6 語言（雖然不是百分之一百相同，不過差異並不大），只是額外增加

很多物件的支援，而且，本書很多範例就是直接改寫自筆者 Visual Basic 語言

相關圖書的範例，如果讀者擁有現成 VB 程式，也一樣可以試著改寫成 Android

或 iOS 版本。 

在行動 App 開發的支援方面，B4A/B4i 是一套完整的快速開發工具，提

供功能強大的 GUI 設計工具，可以直接使用類似 Visual Studio 表單設計工具

來建立支援各種螢幕尺寸和解析度的使用介面，輕鬆設計和建立行動 App 的

使用介面。 
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第二篇：B4A 的 Android 程式設計 

 6-1 B4A 的 GUI 設計工具 

B4A 的 GUI 設計工具可以連接 Android 模擬器或實機來幫助我們建立使

用介面的版面配置。基本上，GUI 設計工具主要是由兩大視窗所組成，即

「Designer」和「Abstract Designer」視窗。 

6-1-1 Designer 視窗 

在啟動 B4A 開發工具後，按一下上方功能表的【Designer】指令，就可

以開啟 GUI設計工具的「Designer」視窗，如下圖所示： 

 

上述「Designer」視窗上方是功能表，之下是連接 Android模擬器或實機

的狀態，勾選右上方核取方塊，可以讓「Designer」視窗永遠顯示在最上層，

右下方是連接裝置的資訊。在中間主要使用介面可以區分成三大區域，如下

所示： 

 屬性清單：在左上方選【Main】標籤，可以看到選擇元件或活動（在

「Abstract Designer」視窗選取）的屬性清單，它是以群組方式來分

 

連接裝置的資訊

版面配置變異

圖檔清單 

屬性清單 

連接狀態 最上層
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類，點選之前  + 或 - 號可以展開或隱藏屬性，其中每一個欄位是

一個屬性，左邊是屬性名稱；右邊是屬性值。 

 圖檔清單：這是在版面配置加入元件或活動所需的圖檔清單，例如：

元件背景的圖片，按【Add Images】鈕可以加入圖檔，在選擇後，按

【Remove selected】鈕刪除圖檔。 

 版面配置變異：因為行動裝置的尺寸和解析度不同，我們可以針對不

同尺寸和解析度新增不同的版面配置變異，請按【New Variants】鈕

新增，進一步說明請參閱第 13-4節。 

  

在「Designer」視窗的【File】功能表可以新增、開啟和儲存使用介面的

版面配置檔，其副檔名為.bal。請注意！開啟 B4A專案和「Designer」視窗有

可能沒有自動載入版面配置檔，此時，請開啟【File】功能表，可以在最後看

到專案的版面配置清單，點選即可開啟，或執行「File > Open」指令自行開

啟副檔名為.bal的檔案，本書的預設名稱是 Main.bal。 

  

在「Designer」視窗的【Add View】功能表可以

新增版面配置所需的介面元件，如右圖所示： 

只需執行指令就可以在 Android 模擬器或實機

的版面配置新增介面元件，我們可以在「Abstract 

Designer」視窗看到新增元件後，就可以拖拉調整位

置、尺寸和在「Designer」視窗修改元件屬性。 

Add View 功能表 

File 功能表 
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在「Designer」視窗的【Tools】功能表可以自動產生成員（Generate 

Members）、調整元件前後重疊位置（Bring to Front/Send To Back）、複製選

擇元件（Duplicate Selected Views）和刪除選擇元件（Remove Selected Views）。 

不只如此，在【Tools】功能表還提供功能來連接或中斷連接 Android 模

擬器或實機，如此，就可以在 Android 模擬器或實機上檢視實際的使用介面

外觀。 

6-1-2 Abstract Designer 視窗 

在 B4A 開發工具按一下上方功能表的【Designer】，就可以進入 GUI 設

計工具的「Designer」視窗，同時開啟「Abstract Designer」視窗（如果沒有

看到，請在「Designer」視窗執行「Tools > Show Abstract Designer」指令），

如下圖所示： 

 

上述視窗是以不同色彩方塊來標示介面元件的位置和尺寸，其內容是元

件的 Name屬性值。當在「Designer」視窗執行「Tools > Connect To Device/ 

Emulator」指令成功連接 Android 模擬器或實機後，就可以執行「Layout > 

Match Connected Device」指令調整成連接裝置的尺寸。 

Tools 功能表 
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在選取元件上按滑鼠【右】鍵，可以看到一個快顯功能表，提供指令來

複製、刪除元件和調整元件前後重疊位置，我們可以將它移至最前或推至最

後。 

最後一個【Generate】指令，可以自動產生此元件的宣告程式碼，或建立

指定事件的事件處理程序。 

請注意！我們在 GUI設計工具建立的介面元件，如果在程式碼會使用到，所有

使用的介面元件需要在活動類別的 Globals 程序中宣告，變數名稱就是 Name

屬性值，因為這些介面元件已經預設初始，所以不需要再呼叫 Initialize()方法

初始物件，就可以馬上使用，如下所示： 

Sub Globals 

    Dim Button1 As Button 

    Dim lblOutput As Label 

End Sub 

 

6-1-3 介面元件的共同屬性 

對於介面元件來說，我們是在「Designer」視窗編輯選擇元件的屬性值，

所有 B4A 介面元件都擁有一些共同屬性，其說明如下表所示： 

屬性 說明 

Name 
元件名稱，建議使用有意義的名稱，而且在開頭使用 3個字
元來標示元件種類，例如：lbl、btn、edt等 

Type 元件型態的唯讀屬性 

Event Name 

處理事件的事件處理程序名稱，預設與 Name屬性值相同。
事件處理程序名稱的格式是此屬性值加上「_」符號，再加
上事件名稱，例如：Event Name屬性值 Button1的 Click事
件處理程序名稱為 Button1_Click 

Parent 
父元件名稱（有些介面元件是容器元件，可以包含子元件），

最上層是 Activity活動 

Left 與父元件左方邊界的 X軸座標，單位是 dip 

Top 與父元件上方邊界的 Y軸座標，單位是 dip 
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屬性 說明 

Width 元件寬度，單位是 dip 

Height 元件高度，單位是 dip 

Enabled 此元件是否可以使用，True是可以；否為不可以 

Visible 此元件是否可見，True是可見；否為隱藏 

Tag 
此屬性是用來儲存額外資訊，以簡化程式設計，在第 6-2-1
節有進一步的說明 

 

上表 Top 和 Left屬性可以決定元件位置，Width 和 Height屬性決定元件

尺寸。 

 6-2 執行功能元件 

Button 按鈕元件是十分重要的元件，它是實際執行功能的圖形使用介

面。在日常生活中的按鈕也隨處可見，例如：門鈴和遊戲控制器的按鈕，按

一下可以響起門鈴聲，或發射子彈射擊。 

基本上，在版面配置建立的 Button按鈕可以分為兩種：文字和圖形按鈕。

在第 6-2-1 節是建立文字按鈕；第 6-2-2 節是圖形按鈕。 

6-2-1 文字按鈕 

Button按鈕介面元件可以觸發 Click或 LongClick事件來執行事件處理程

序，例如：在輸入資料後，按下按鈕顯示計算結果或更改屬性等操作，如下

圖所示： 

 

上述按鈕元件預設使用文字顯示按鈕的標題文字，即建立文字按鈕。按

鈕的操作是按一下來表示按下按鈕。 
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Button元件的常用屬性說明，如下表所示： 

屬性 說明 

Text 按鈕的標題文字 

TextStyle 

指定標題文字的樣式，包含：Typeface字型、Style 字體（正常、
粗、斜和粗斜）、Horizontal Alignment 水平對齊、Vertical 
Alignment垂直對齊、Size尺寸和 Text Color的文字色彩 

Pressed 指定按鈕是否預設按下 
 

  

Button 元件的 Tag 屬性可以指定額外的訊息文字，以便當共用事件處理

程序時，可以讓我們使用 Sender關鍵字取得事件來源物件後，可以進一步判

斷事件來源是哪一個元件。 

例如：本節範例的 2個 Button元件，其 Event Name 屬性都是 Button，換

句話說，這 2 個按鈕共用同一個 Click事件處理程序 Button_Click，如下所示： 

Sub Button_Click 

    Dim btn As Button  ' 事件來源按鈕 

    btn = Sender 

    If btn.Tag = "Button1" Then  ' 是 Button1 

        … 

    Else  ' 是 Button2 

        … 

    End If 

End Sub 

上述事件處理程序是使用 Sender關鍵字取得事件來源的 Button元件，如

下所示： 

Dim btn As Button 

btn = Sender 

上述程式碼首先宣告 Button 物件，然後指定其值為 Sender，即型態轉換

成 Button元件，因為在使用介面擁有 2 個 Button元件，If/Else條件就是使用

Tag屬性值來判斷是 Button1，還是 Button2。 

Tag 屬性與 Sender 關鍵字 

Button 元件的屬性 
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 B4A 專案 Ch6-2-1\猜樸克牌點數.b4a 

在 B4A 專案建立猜樸克牌點數大小的遊戲，

使用 2 個 Button 元件模擬 2 張樸克牌，按一下可

以顯示點數，讓我們猜測 2 張牌中，哪一張牌的

點數比較大（點數是由亂數產生），如右圖所示： 

按【樸克牌 1】鈕或【樸克牌 2】鈕，可以顯

示點數，後面的星號表示這是使用者按下的哪一

個 Button按鈕。 

 

 

 

 

  

請建立 B4A專案「Ch6-2-1\猜樸克牌點數.b4a」，專案屬性 ApplicationLabel

與活動標題 Title同為【猜樸克牌點數】，套件名稱是【ch06.gui.b4a.example】。 

  

在版面配置新增與編排 2個 Button元件，如右

圖所示： 

 

版面配置：Main.bal 

GUI 設計工具 
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請選取各元件後，更改各元件的屬性值，如下表所示： 

介面元件 屬性 屬性值 

Button1 Event Name Button 

Button1 Tag Button1 

Button1 Text 樸克牌 1 

Button2 Event Name Button 

Button2 Tag Button2 

Button2 Text 樸克牌 2 

  

在 Main模組輸入 Globals、Activity_Create和 Button_Click事件處理程序

的程式碼，如下所示： 

01: Sub Globals 

02:     Dim Button1 As Button 

03:     Dim Button2 As Button 

04: End Sub 

05:  

06: Sub Activity_Create(FirstTime As Boolean) 

07:     Activity.LoadLayout("Main") 

08:     Activity.Title = "猜樸克牌點數" 

09: End Sub 

… 

19: Sub Button_Click 

20:     Dim num1, num2 As Int 

21:     num1 = Rnd(1, 13)  ' 取得點數 

22:     num2 = Rnd(1, 13) 

23:     Dim btn As Button  ' 事件來源按鈕 

24:     btn = Sender 

25:     If btn.Tag = "Button1" Then  ' 是 Button1 

26:         Button1.Text = num1 & "*"  

27:         Button2.Text = num2 

28:     Else  ' 是 Button2 

29:         Button1.Text = num1  

程式碼編輯器 

介面元件屬性 
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30:         Button2.Text = num2 & "*" 

31:     End If 

32: End Sub 

  

 第 2~3列：宣告名為 Button1和 Button2物件變數的 Button元件，它

們是在 GUI 設計工具新增的介面元件，因為在程式碼需要使用這些

物件，所以需要在 Globals 程序宣告，如此才能在 Button_Click 事件

處理程序中使用。 

請注意！不同於第 4 章 StringBuilder、List 和 Map 等物件，在 GUI 設計工具

新增的元件，預設就會呼叫 Initialize()方法來初始物件，所以在 Main模組並不

需要初始這些在 GUI設計工具加入的元件，就可以馬上使用。 

 

 第 6~9 列：Activity_Create 程序是在第 7 列指定載入的版面配置檔

Main.bal，第 8 列指定活動的標題文字。 

 第 19~32 列：Button_Click事件處理程序是在第 21~22 列使用亂數取

得點數，第 23~24 列取得事件來源物件，第 25~31 列的 If/Else 條件

使用 Tag 屬性判斷來源是 Button1 或 Button2，以便指定不同的 Text

屬性值。 

6-2-2 圖片按鈕 

圖片按鈕的功能和文字按鈕相同，只是顯示外觀是一張圖片，背景圖片

支援 GIF、JPG、BMP 和 PNG格式的圖檔。其相關屬性的說明，如下表所示： 

屬性 說明 

Drawable 
選 StatelistDrawable，就可以指定按鈕的圖片檔案來建立圖片按
鈕，而且還可以指定不同狀態顯示的圖片 

上表 Drawable 屬性是用來指定介面元件使用的背景 Drawable 物件，可

以是 ColorDrawable純色物件、GradientDrawable漸層物件或 BitmapDrawable

圖檔物件，在第 11-1節有進一步的說明。 

程式碼說明 
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當我們在 Drawable屬性選【StatelistDrawable】，就可以進一步指定相關

屬性來指定不同狀態時顯示的 Drawable物件，其常用屬性的說明，如下表所

示： 

屬性 說明 

Enabled Drawable 
正常按鈕背景顯示的 Drawable物件，屬性值可以是

ColorDrawable、GradientDrawable或 BitmapDrawable 

Disabled Drawable 
沒有作用按鈕顯示的 Drawable物件，屬性值可以是

ColorDrawable、GradientDrawable或 BitmapDrawable 

Pressed Drawable 
按下按鈕顯示的 Drawable物件，屬性值可以是

ColorDrawable、GradientDrawable或 BitmapDrawable 

Image file 
當選擇 BitmapDrawable，就可以在此欄位選擇我們在
「Designer」視窗加入的圖檔 

Gravity 
指定圖檔顯示方式是填滿（Fill）、置中（Center）或位
在左上角（Top-Left） 

 

如果選 ColorDrawable，可以指定顯示的純色色彩（Color）、四角的圓角

半徑（Corner radius）和透明度（Alpha）。選 GradientDrawable，可以指定第

1和第 2 個色彩（First Color/Second Color），Orientation是漸層方向，以便

從第 1個色彩以此方向漸層至第 2 個色彩。 

 B4A 專案 Ch6-2-2\猜樸克牌人頭.b4a 

在 B4A 建立猜樸克牌人頭遊戲，這是 3 張樸

克牌背面的圖形按鈕，按下按鈕，可以顯示樸克

牌正面，如右圖所示： 
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請建立 B4A專案「Ch6-2-2\猜樸克牌人頭.b4a」，專案屬性 ApplicationLabel

與活動標題 Title同為【猜樸克牌人頭】，套件名稱是【ch06.gui.b4a.example】。 

  

在版面配置新增與編排 3個 Button元件，如下圖所示： 

 

因為本節專案是建立圖片按鈕，我們需要新增按鈕所需的圖檔，其步驟

如下所示： 

 請開啟「Designer」視窗，可以在右上方看到 Image Files框。 

 

版面配置：Main.bal 

GUI 設計工具 
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 按【Add Images】鈕，可以看到「Choose image files」對話方塊。 

 

 請切換至「Basic4android\Ch06」目錄選【Back.jpg】，按【開啟】鈕

加入圖檔，同樣方式，請依序加入 D13.jpg、D8.jpg 和 H7.jpg 圖檔，

如下圖所示： 

 

  

請依序選 3 個按鈕元件後，更改元件的 Button Properties 屬性值，以

Button1為例，其屬性設定步驟，如下所示： 

介面元件屬性 
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 請在【Drawable】屬性選【StatelistDrawable】，可以看到下方展開的

屬性清單，如下圖所示： 

 

 在【Enabled Drawable】屬性選【BitmapDrawable】，可以看到下方展

開的 Image file屬性，如下圖所示： 

 

 請在【Image file】屬性選【Back.jpg】圖檔後，在下方【Pressed Drawable】

屬性選 BitmapDrawable，【Image file】屬性選【D8.jpg】，如下圖所示： 

 

請重複上述步驟指定 Button2~3 的屬性， Enabled Drawable 都是

Back.jpg；Pressed Drawable依序是 D8.jpg、D13.jpg和 H7.jpg。 
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在 Main模組輸入 Activity_Create程序的程式碼，如下所示： 

01: Sub Activity_Create(FirstTime As Boolean) 

02:     Activity.LoadLayout("Main") 

03:     Activity.Title = "猜樸克牌人頭" 

04: End Sub 

  

 第 1~4 列：Activity_Create 程序是在第 2 列指定載入的版面配置檔

Main.bal，第 3 列指定活動的標題文字。 

 6-3 文字輸出入元件 

B4A 使用介面的文字元件主要有兩種：Label和 EditText元件，一個可以

顯示文字內容；一個是用來輸入文字內容。對比應用程式的輸出入，Label

是程式輸出；EditText是程式輸入。 

6-3-1 Label 輸出元件 

Label標籤元件（Android是 TextView元件）是一種資料輸出元件，可以

用來顯示程式執行結果、欄位說明文字和狀態，例如：按下按鈕，在 Label

標籤顯示數學運算或字串連接的結果，如下圖所示： 

 

上述圖例是在 Label元件顯示一段字串內容。 

程式碼說明 

程式碼編輯器 
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Label元件的常用屬性說明，如下表所示： 

屬性 說明 

Text Label元件顯示的字串內容 

Multiline Text Label元件顯示的多行字串內容 

TextStyle 

指定文字樣式，包含：Typeface字型、Style字體（正常、
粗、斜和粗斜）、Horizontal Alignment水平對齊、Vertical 
Alignment垂直對齊、Size尺寸和 Text Color的文字色彩 

Drawable 指定背景色彩、漸層或圖片 
 

  

在 B4A程式碼是使用 Text屬性存取元件內容，如下所示： 

Label3.Text = Label1.Text & Label2.Text 

上述程式碼取得 Label1和 Label2的內容後，指定給 Label3，即在 Label3

元件顯示連接字串的結果。 

  

Label元件支援 Click與 LongClick事件，換句話說，我們也可以使用 Label

元件來模擬按鈕功能，如下所示： 

Sub Label4_Click 

    Label3.Text = Label1.Text & Label2.Text 

End Sub 

上述事件處理程序是用來處理按一下 Label元件的 Click事件。 

Label 元件的 Click 與 LongClick 事件 

存取 Label 元件的內容 

Label 元件的屬性 
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 B4A 專案 Ch6-3-1\輸出連接字串.b4a 

在 B4A專案輸出 2 個字串的連接結果，可以

將第 2 個 Label 元件 Text 屬性值連接至第 1 個

Label元件的最後，然後在第 3個 Label元件顯示

字串連接的結果，按鈕是使用 Label元件來模擬，

如右圖所示： 

按【連接】鈕可以將上方 2 個字串連接顯示

在最下方 Label元件。 

 

 

 

 

  

請建立 B4A專案「Ch6-3-1\輸出連接字串.b4a」，專案屬性 ApplicationLabel

與活動標題 Title同為【輸出連接字串】，套件名稱是【ch06.gui.b4a.example】。 

  

在版面配置新增與編排 4個 Label元件，如右

圖所示： 

 

版面配置：Main.bal 

GUI 設計工具 
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請選取各元件後，更改各元件的屬性值，如下表所示： 

介面元件 屬性 屬性值 

Label1 Text Basic4android 

Label2 Text 程式設計 

Label4 Text 連接 

Label4 Horizontal Alignment CENTER_HORIZONTAL 

Label4 Size 30 

Label4 Color 藍色 

Label4 Alpha 255 
 

  

在 Main模組輸入 Globals、Activity_Create和 Label4_Click事件處理程序

的程式碼，如下所示： 

01: Sub Globals 

02:     Dim Label1 As Label 

03:     Dim Label2 As Label 

04:     Dim Label3 As Label 

05: End Sub 

06:  

07: Sub Activity_Create(FirstTime As Boolean) 

08:     Activity.LoadLayout("Main") 

09:     Activity.Title = "輸出連接字串" 

10: End Sub 

… 

20: Sub Label4_Click 

21:     Label3.Text = Label1.Text & Label2.Text 

22: End Sub 

  

 第 2~4 列：宣告名為 Label1~4 的 Label 元件，它們是 GUI 設計工具

新增的元件。 

程式碼說明 

程式碼編輯器 

介面元件屬性 
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 第 7~10 列：Activity_Create 程序是在第 8 列指定載入的版面配置檔

Main.bal，第 9 列指定活動的標題文字。 

 第 20~22 列：Label4_Click事件處理程序是在第 21 列連接 2 個 Label

元件的內容。 

6-3-2 EditText 輸入元件 

EditText元件是程式的輸入元件，可以讓使用者以鍵盤輸入程式所需的資

料。例如：姓名、帳號和電話等，如下圖所示： 

 

上述圖例的左邊是 Label 元件的欄位標題文字；右邊是輸入資料的

EditText元件。 

  

EditText元件的常用屬性說明，如下表所示： 

屬性 說明 

Text 輸入的內容 

Password 是否是密碼欄位，預設值 False不是；True為是 

Single Line 是否是單行文字方塊，預設值 True是；False是多行文字方塊 

Input Type 
屬性值可以決定元件允許輸入的內容，例如：NUMBERS 整數、

TEXT文字、PHONE電話號碼和 DECIMAL_NUMBERS浮點數 

Hint Text 提示文字的內容 

Hint Color 提示文字的色彩 

Wrap 
如果是多行文字方塊，輸入的資料是否自動換行，預設值 True
為是；False為不換行 

EditText 元件的屬性 
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在 B4A程式碼取得使用者輸入資料是使用 Text屬性，如下所示： 

Dim w As Double = edtWeight.Text 

上述程式碼指定變數 w 的值，因為 w 是 Double 型態，B4A 會自動將

EditText元件輸入的字串轉換成浮點數。 

 B4A 專案 Ch6-3-2\BMI 計算機.b4a 

在 B4A專案建立 BMI計算機，只需輸出身高和體重，就可以計算和顯示

BMI 值，如下圖所示： 

 

請輸入身高（公分）和體重（公斤）後，按【計算 BMI】鈕，就可以在

下方顯示 BMI 值的計算結果。 

 

請建立 B4A專案「Ch6-3-2\BMI 計算機.b4a」，專案屬性 ApplicationLabel

與活動標題 Title同為【BMI計算機】，套件名稱是【ch06.gui.b4a.example】。 

GUI 設計工具 

取得使用者輸入的資料 
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在版面配置新增與編排 3個 Label（Label1~2、lblOutput）、2 個 EditText

（edtHeight、edtWeight）和 1個 Button元件，如下圖所示： 

 

  

請選取各元件後，更改各元件的屬性值，如下表所示： 

介面元件 屬性 屬性值 

Label1 Text 身高: 

Label2 Text 體重： 

edtHeight Input Type DECIMAL_NUMBERS 

edtHeight Hint Text 輸入身高… 

edtWeight Input Type DECIMAL_NUMBERS 

edtWeight Hint Text 輸入體重… 

Button1 Text 計算 BMI 

lblOutput Horizontal Alignment CENTER_HORIZONTAL 

lblOutput Color 藍色 

lblOutput Alpha 255 

介面元件屬性 

版面配置：Main.bal 
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學習評量 

(  ) 1.  請問下列哪一個「Designer」視窗功能表可以新增版面配置所需的元件？ 

   A.File  B.Add View  

  C.Add Control  D.Tools 

(  ) 2.  請問下列哪一個介面元件屬性可以指定處理事件的事件處理程序名稱？ 

   A.Name  B.Type  

  C.Parent  D.Event Name 

(  ) 3.  請問下列哪一個不是 EditText 元件支援的事件？ 

  A.EnterPressed  B.FocusChanged  

C.CheckedChange  D.TextChanged 

(  ) 4.  請問下列哪一個是 B4A 單選功能的選擇元件？ 

  A.Label  B.TextBox  

C.RadioButton  D.CheckBox 

(  ) 5.  請問活用 CheckedChange 事件可以取代下列哪一種介面元件，建立

出更容易操作的使用介面？ 

   A.Button   B.Label  

  C.TextBox  D.TextView 

6.  請問 B4A 的 GUI 設計工具主要是由哪兩大視窗組成？ 

7.  請說明 Name 和 Event Name 屬性的差異？Tag 屬性的用途為何？ 

8.  請建立 B4A 專案的速食店行動點餐系統，可以選擇主餐、薯條和飲料，

按【點餐】鈕，就可以在 Label 元件顯示總價。  
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